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1.0 Overview 
The Secure Analysis Environment (SAE) is a security extension to Healthideas that secures warehouse 
data assets, particularly where those assets involve directly identifiable patient health records. The 
SAE essentially serves to control access to Healthideas through a virtual desktop environment with 
enhanced security features as compared to a regular government desktop: 

• Restricts the transfer of data out of SAE. From within SAE, you cannot copy data from your 
virtual desktop to your physical computer: 

o No copy and paste from SAE to your desktop 

o No e-mail, internet access, printer or normal LAN within SAE 

• Managed transfer of data in and out of SAE. Transfer of data either in or out of SAE is 
controlled through a secure file transfer protocol (SFTP) that logs all files that enter or leave the 
environment. This service is called the “Managed Transfer Process” (MTP). 

• Secure LAN. The SAE replaces the shared government LAN with a secure LAN that is only 
accessible from within the secure environment. 

2.0 Getting Started 
This chapter describes how to access the SAE for the first time and set up your environment so that 
you can begin working with data in Healthideas. 

2.1 Pre-Requisites 
To connect to the SAE and work within it, you will require the following: 

• An SAE IDIR account that you will use to access the SAE. 

• Authorization for your SAE IDIR to access the SAE. 

• Within the SAE, access to one or more SAE control/access groups.  These determine the desktop 
applications that you can use within SAE and the secure LAN folders that you can access. 

For those users who need to transfer data into or out of the SAE, you will need authorization to use the 
Managed Transfer Process (MTP). 

In addition, a separate OID account is required if you require access to the Healthideas data warehouse.  
This access is not required if you are using the SAE to access or share files within a team LAN folder. 

2.2 Logging into the SAE for the first time 
Open a web browser and navigate to https://sae.healthideas.gov.bc.ca/. 

The following log-in screen displays: 

https://sae.healthideas.gov.bc.ca/
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Enter your SAE IDIR Username and Password and click Log On. 

If prompted to change your SAE IDIR password, please ensure your new password does not contain 
any of these characters:  

,   comma  

.   dot 

*  asterisk 

;  semicolon 

In order to increase the strength of your IDIR password, it is recommended that your password 
includes one or both of the following characters:  # - hash, or     _ - underscore 

Please Note: If this is the first time you are accessing the SAE, you will be prompted to download and 
install the Citrix Receiver application, which is used to display the remote desktop.  For more details 
about this, please refer to Section 2.2.1 Installing Citrix Receiver. 

The Citrix StoreFront page will appear with the Home tab open.   
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Navigate to the Desktops tab:  

 
 

On the Desktops tab, select SAE_Production. 
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The server will display a security warning that you must acknowledge by clicking OK. 

 
 

You may get the following pop-up security warning. If so, click on Permit use and check the box that 
states “Do not ask me again for this site”. 

 

Now you are inside the SAE Desktop, which is like a Windows desktop. The SAE Desktop will appear 
with shortcuts to various standard programs available within the SAE. From here, you will be able to 
use the SAE as if it were any other computer, with two important distinctions: you will not be able to 
access the Internet from within the SAE and disconnecting from the SAE will not terminate your 
session, so you must ensure that you log off. 
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Please Note: The Operating System (OS) used for the SAE is Windows Server 2019. 

2.2.1 Installing Citrix Receiver 

The SAE uses Citrix XenApp to present a ‘published desktop’.  To do this, Citrix Receiver (ICA Receiver) 
must be installed on your local machine.  When you log onto the SAE website for the first time, you will 
be prompted to download and install Citrix Receiver. 

Please Note: The installation process is different for Ministry of Health users and Third Party (external) 
users. See the appropriate section below. 

2.2.1.1 Ministry of Health users 

To install Citrix Receiver: 

1. Open a web browser and navigate to https://sae.healthideas.gov.bc.ca/. 

2. After signing in using your SAE IDIR, the following screen appears, prompting you to 
install Citrix Receiver: 

 

https://sae.healthideas.gov.bc.ca/
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3. Before installation, you must first agree to the terms of the Citrix license agreement.  
Select the check box indicating that you agree and then click Install to begin installation.  
A prompt window will display at the bottom of the browser screen asking you to either 
Run or Save the software program. Click Run. 

 
4. The Citrix Receiver setup window will display. Click Start. 

 
5. The License Agreement window will display.  After reviewing the agreement, select the 

checkbox indicating that you agree and click Install. 
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6. The Installation Successful window will display once the software installation has 
finished.  Click Finish. 

 
7. You will now be prompted to log onto the Citrix StoreFront.  If the page does not display, 

navigate to the SAE web address (https://sae.healthideas.gov.bc.ca/). 

Please Note: It may take a few minutes to log into the SAE from Citrix for the first time as your user 
profile will need to be created by Windows.   

2.2.1.2 Third party (external) users 

To install Citrix Receiver: 

1. Open a web browser and navigate to https://sae.healthideas.gov.bc.ca/vpn/index.html 

2. It will prompt you to install CitrixReceiverWeb.exe. 

Select “Run”.   

 
3.  Click on Start. 

 

https://sae.healthideas.gov.bc.ca/
https://sae.healthideas.gov.bc.ca/vpn/index.html
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4. The License Agreement window will display.  After reviewing the agreement, select the 
checkbox indicating that you agree and click Install. 

 
5. The Installation Successful window will display once the software installation has 

finished.  Click Finish. 

 
6. You will now be prompted to log onto the Citrix StoreFront.  If the page does not display, 

navigate to the SAE web address (https://sae.healthideas.gov.bc.ca/). 

Please Note: It may take a few minutes to log into the SAE from Citrix for the first time as your user 
profile will need to be created by Windows.   

2.3 Signing out of the SAE 
When you have finished using the SAE, make sure you have saved all your work, then sign out of the 
session.  

IMPORTANT: Do not click on Shut Down to disconnect the session.  

Also, please do not leave a session running over night or over the weekend.  

To sign off properly, please follow the following steps  

https://sae.healthideas.gov.bc.ca/
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1. Click on the Start icon  

2. Click on your username  

3. Click on Sign out 

These three steps are shown in the screenshot below: 

 

2.4 Working within the Citrix Receiver window 

When working in the SAE, you are essentially running two separate computers at the same time. This 
can cause a bit of confusion, particularly when using your keyboard. For example, when you press 
the Start key, are your wanting to open the Start menu on your local workstation, or the Start screen 
in SAE? When you copy or cut some text, is the text copied to your clipboard on your local machine, 
or the clipboard in SAE (or both)? 

This section describes: 

• How to move back and forth between the Citrix desktop and your workstation 

• How to copy data into your SAE desktop 
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2.4.1 Using the Citrix Receiver toolbar menu 

The Citrix toolbar menu is located at the top of the SAE desktop. Click on the toolbar to expand it.   

  
The following table describes the buttons on the Citrix Receiver toolbar. 

Citrix Menu 
Icons 

Description 

 ￼ Minimize Citrix Receiver and return you to your own desktop.  

To return to Citrix, click the Citrix Receiver icon in your taskbar: 

 

 ￼ Send the Ctrl-Alt-Delete keystroke to the virtual desktop. This provides 
an alternative method for disconnecting the session or accessing Task 
Manager. 

￼ Display preferences for Citrix Receiver. Preferences mainly involve 
options for how the virtual desktop communicates with your local 
workstation: these capabilities are generally not available within SAE. 

 ￼ Toggle between displaying the SAE desktop in full screen mode or in a 
scalable window on your desktop. 
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Citrix Menu 
Icons 

Description 

 ￼ Disconnect when you want to keep an SAE session running due to 
ongoing processing.  

Note: Disconnected sessions will be terminated without warning 
during announced outage periods. 

￼ This menu includes shortcuts for standard Windows commands, such 
as displaying the Start screen and the Charms toolbar.  

2.5 Moving information into and out of the SAE 
The SAE does not allow for the direct movement of files in or out of the SAE through the use of drag 
and drop, the clipboard, or saving files directly to the workstation desktop. All information transfer 
must be done through the Managed Transfer Process (MTP) --- see section 4 for details. 

2.6 Printing information from the SAE 
The SAE does not include connections to any printers. If you need to print, you must first create a file, 
and then remove it from the SAE using the Managed Transfer Process (MTP) (see section 4). There 
are a few options for how you might want to do this, but all of them involve removing the file to be 
printed from the SAE: 

• Remove file: Remove the file and print it directly from your workstation. 

• Save as PDF: Most applications include a “Save as PDF” feature. For example, in Microsoft Word, 
go to the File menu, select Save As and then select PDF in the Save as Type field. 

2.7 Using secure file storage within the SAE 
Within the SAE, all your data is stored on the secure LAN, either on your personal H: drive (not the 
same as your usual H: drive), or in a shared team folder. 

Folder Location Purpose 

Personal 
folder (H:) 

\\semillon\HomeFolders$\your_idir.IDIR Like the H: drive on your local machine but located 
within the secure LAN and only accessible from 
within the SAE. Each user in the SAE has their own 
personal H: drive, which is automatically mapped 
when you sign into the SAE. 
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Folder Location Purpose 

Group team 
folder 

\\semillon\Groups\your_team_folder The “Groups” folder is the main share on the secure 
LAN server (Semillon). This location includes folders 
for the various teams that use SAE—depending on 
your data access, you may have access to one or 
more of these folders. To access this folder, you 
need to map it first. 

2.8 Accessing web applications within the SAE 
Although the SAE does not provide Internet access, you are able to access Healthideas secure web 
applications including MicroStrategy and the secure report application. 

To log in to Healthideas from within the SAE: 

1. Open your browser and copy and paste the following URL to your browser to open the 
Healthideas secure portal :  

https://secure.healthideas.gov.bc.ca/ 

2. Log in using your Oracle ID (for example, alice_smith_lvl3). 

Access to the secure applications is available from within the Healthideas portal. 

To change your OID password, log in to the Healthideas secure portal as above. 

3.0 Tools for connecting to the Healthideas database 

3.1 PL/SQL Developer 
1. Click on the plsqldev icon to launch the application. 

 
2. Enter your OID and password in the login window and select HI_PRD.AQYP as the Database.  

 
3. Click on OK. 
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Please Note: The first time you start PL/SQL Developer, the application may crash. If that happens, 
please start it again. Then, after the application restarts, if it is still not working properly, please do 
the following: 

• Open Tools → Preferences 

 
 

• Then ensure OracleClient19Home1 is selected in the “Oracle Home” dropdown  

 

• When you have done that, click “OK” to save your changes. 

3.2 Golden 
1. Click on the Golden6 icon to launch the application. 
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2. Enter your username (OID) and password in the login window and select HI_PRD.AQYP as the 
Database.  

 
3. Click on Login. 

Please Note: The first time you use Golden on the new server, the application may not recognize the 
new Oracle Home. If the application crashes or does not run properly, please follow the following 
steps: 

• On the “Database Login” screen click Options… 
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• Enter E:\APPS\Oracle\instantclient_19_12_x32\oci.dll in the Oracle Client DLL box. 

• Make sure “Add items from tnsnames.ora” is checked 

• Click OK 

• Close and re-start Golden session 

3.3 SQL Developer 

The following screenshot shows the settings you will need in SQL Developer to connect to 
Healthideas.

 
 

4.0 Managed Transfer Process (MTP)  
You can use the Managed Transfer Process (MTP) to transfer files into and out of the SAE. The MTP is 
an SFTP-based file transfer process and is the only allowed method of transferring files into and out 
of the SAE.  

To use the MTP, you will need to install a file transfer tool. We recommend FileZilla.  
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FileZilla is available to government employees from the B.C. Government’s Software Center app. 
Third party users will need to install an SFTP application themselves.  

Within the SAE, FileZilla is already pre-installed, so you do not need to install it within the SAE. 

Moving files into or out from the SAE is a two-step process: 

1. Upload the file(s) to the MTP server. 

2. Download the file(s) from the MTP server. 

Use the following link to access the MTP service: saemtp.hlth.gov.bc.ca. 

Note that authentication is the same as for the SAE. 

IMPORTANT: Please note that users transferring files into or out of the Secure Analysis Environment 
(SAE) must fill out an MTP Cover Form for every transfer. This form is available from the SAE Desktop 
or online at the following link: MTP Cover Form (DOCX, 54KB). Please transfer the completed MTP 
Cover Form alongside the file(s) you are transferring. 

4.1 Pre-requisites 

4.1.1 Installing FileZilla 

Third party users can install FileZilla for free from the web. 

B.C. Government employees should follow the following steps: 

To install FileZilla on your government laptop: (for B.C. Government employees only) 

1. Open Software Center application and search for FileZilla. 

https://www2.gov.bc.ca/assets/gov/health/conducting-health-research/data-access/mtp-cover-form.docx
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2. Click the FileZilla icon. The FileZilla install window will display. Click Install. 

 
3. When the installation has finished, the application details window will display the Uninstall 

button.  
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4. You can find the software in the menu Installation status. 

 

4.1.2 Setting up FileZilla 

You will need to follow this process twice for both your local machine and within the SAE 

1. Open FileZilla 
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2. Click the Site Manager button on the top left-hand corner. 

 
3. Then the Site Manager window will open. 
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4. Click New Site. 
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5. You will now be able to manage a new site. You can rename the site if you wish. The new site 
is renamed as “MTP” in this guide. 

 
6. Set up the site entering the following settings: 

Protocol:  Choose SFTP – SSH File Transfer Protocol 

Host:   Enter saemtp.hlth.gov.bc.ca 

Post:   Enter 22 

Logon Type:  Choose Ask for Password 

User:   Enter your IDIR name. 

7. Click OK to save the site settings. 
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4.1.3 Logging in to the MTP 

There are two ways of logging in to the MTP: from the saved site and using Quickconnect. 

4.1.3.1 Login from the saved site 

1. Click the dropdown next to the “Site Manager” button. Choose the site you will connect to. 

 
2. The “Enter password” window will display. Enter your password, then click OK. 
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3. An “Unknown host key” window will appear. Click OK. 
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4. You should then be connected. “Remote site” will be shown at the right. 

 
 

4.1.3.2 Login using Quickconnect 

1. Enter the following host on the top left-hand corner: saemtp.hlth.gov.bc.ca. 

 
2. Enter your Username (SAE IDIR Account) and Password. 
3. Enter the Port: 22 
4. Click Quickconnect 
5. An “Unknown host key” window will appear. Click OK 
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6. You should then be connected. After connecting, you will be logged into your own account. 

 

4.2 Moving files into the SAE 
1. Open FileZilla on your personal machine. 
2. Log in to MTP (as above). 
3. In FileZilla, select the files that you would like to transfer from your personal machine (Local 

site on the left-hand side).  
4. Drag and drop the files to the Remote site (on the right-hand side).  The files will be 

automatically transferred into the MTP server. 
5. Then open FileZilla within the SAE. 
6. Log in to MTP. 
7. Select the files that you would like to transfer into the SAE on the right-hand side.  
8. Drag and drop the files you selected to the Local site on the left-hand side.  The files will be 

automatically transferred into the SAE. 
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Note: “Remote site” refers to the MTP server.  

4.3 Moving files out of the SAE 
1. Open FileZilla within SAE.  
2. Log in to MTP (as above). 
3. In FileZilla, select the files that you would like to transfer from the SAE (Local site on the left-

hand side). 
4. Drag and drop the files to the Remote site (on the right-hand side).  The files will be 

automatically transferred into the MTP server. 
5. Then open FileZilla on your personal machine. 
6. Log in to MTP. 
7. Select the files that you would like to transfer to your personal machine from the remote site 

(right hand side).  
8. Drag and drop the files to the folder you selected in the local site (left hand side).  The files will 

be automatically transferred into your personal machine. 

5.0 Service Offerings 
If you have questions about any of the following services or would like to request any of the services, 
contact   Healthideas@gov.bc.ca  

The following is a list of the services available to SAE users: 

Service Description 

Access to  SAE Secure LAN Folder Request Request access to a secure folder only accessible 
from within the SAE 

Managed Transfer Process (MTP) Request This includes the setup of the user accounts 
used for the MTP 

New/Update SAE Secure LAN Folder Request Creation of a new secure LAN folder within the 
SAE 

New Application Installation Request Access to software not installed in SAE 

General Service Request Any other request, including problems arising 
during the use of existing services. 

mailto:Healthideas@gov.bc.ca
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